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[1] Einführung in die Matrix-Algebra / Mit Anwendungen in der Statistik, Karsten Schmidt & 

Götz Trenkler, Springer 
 
[2] Wiskunde voor hoger onderwijs door middel van Derive 1 & 2, Peter van der Velden et al., 

Academic Service – SDU, The Hague, NL 
 
[3] Experimente und Visualisierung, mit Beiträgen von G. Schmidt, E. Lehrmann, J. Böhm.,  

MU Der Mathematikunterricht, Jg 52, Heft 4-2006, Erhard Friedrich Verlag, Seelze 
 
[4] Dynamisch Geometrie entdecken, Elektronische Arbeitsblätter für die 7. – 10. Klasse,  

H.-J. Elschenbroich u. Günter Seebach , coTec-verlag 
 
[4] and many other valuable books (German and English) are available from 

http://shop.bk-teachware.com 
 
Recommended websites: 
 
For your information: 

http://www-fourier.ujf-grenoble.fr/~parisse/english.html 
Daniel Legendre 
 

 
 
 
Nils Hahnfeld was busy as ever … 
 

GREAT NEWS: Calculus Made Easy version 8.0 is now available. 
  
Calculus Made Easy v8.0 has become the ultimate educational tool to study Calculus.  
 
No other software provides detailed Step by Step Solutions to Integration (using U-Substitution 
(choose u yourself or let CME do it for you!), Integration by Parts, by Partial Fractions, Power Rule, 
Expand/Rewrite, Arctan(x) and Arcsin(x) Integrals, etc) and Differentiation (Chain-, Power- , Product- 
and Quotient Rule) problems.  
 
Just enter the given function and learn how the correct rule is applied - step by step - until the final 
answer is derived.   
 
No other software covers Calculus I (Calc AB) , II (Calc BC) , III (multivariable), Differential Equations, 
Vector Calculus and Differential Geometry!!  
 
To view some examples, check here: www.ti89.com/documentation.htm  
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Dear DUG-Members, 
with some delay and with many I present 
DNL#63. I must admit that I intended to skip 
DNL#63 and intended to have a double issue 
63/64 in December but then I prepared a paper 
for a seminar – the nonlinear regression – and 
from one moment to the other I wanted to put 
it into a smaller than usual DNL#63. As you 
can see, it did not luck. This issue is again a 
full publication. Many mails from and to Peter 
Schofield, Karsten Schmidt, Bernhard Kutzler, 
Tania Koller and Bill Wilburn were exchanged 
and I am happy that the 44 pages are again full 
of materials. 
 
In this DNL you might have your first meeting 
with the new TI-CAS device and software TI-
Nspire. Bernhard Kutzler gives a short intro-
duction. If anybody of you has some experi-
ence with Nspire, he or she are friendly wel-
come to share it with us. The developers an-
nounce that as many DERIVE features as pos-
sible will be implemented into Nspire. I hope 
that they will have enough inspiration to do it! 
 
Several DUG-members asked if we could not 
open our publication for other computer alge-
bra systems. Of course, we can and we start 
with our first special CAS guest, 
MATHEMATICA. Bill Wilburn sent a respec-
tive contribution. It might be nice for students 
to reproduce calculation and graph with 
DERIVE (or the TI!). So if you have any arti-
cle in Maple, MuPAD, Mathematica, Auto-
graph (which is not a CAS, but a very fine 
math program) etc, then please send it to me. 
 
I complained for years that DERIVE is unable 
to plot in different line thicknesses. Tania 
Koller shows us to overcome this deficiency. 
The “trick” is so easy and I am very disap-
pointed that it was me who found it. Tania´s 
students are very eager using thick lines and 

also combining DERIVE and a graphic pro-
gram – which is also very novel. (I am quite 
sure that many of you had never tried this). 
Tania sent a collection of Halloween-Ghosts 
which were created by applying polynomial 
functions. They are all descendants of Paul 
Drijver´s ghost – Hi Paul, do you remember 
Krems 1993, where you presented your ghost? 
Your ghost feels very well and has survived in 
our regions (maybe because of the excellent 
wines of Krems and surroundings?) 
 
Admire the creativity of Tania´s students on 
pages 6 and 14. 
 
One contribution is redemption of my promise 
of DNL#59 to produce contour plots in 
DERIVE. This is in a tight connection with 
implicit plots and so we can have implicit plots 
with thick lines. Thanks Peter Schofield for 
your great cooperation. It was just yesterday 
that Peter sent his improved tool for numeri-
cally solving equations which is used for cal-
culating the level curves. (More about this in 
DNL#64.) 
 
Some interesting requests are remaining for the 
next DNL (Slider bars and Arrows, a very fine 
tool to collect coordinates of 2D-points in the 
Algebra window, a TI-bug?, …). 
 
I received a fine article from G P Speck, New 
Zealand, who rejoined the DUG, welcome 
again. 
 
Finally I´d like to invite you to order the Pro-
ceedings CD of the DES-TIME Conference. It 
is full of materials (papers, programs, files, 
pictures, …) 
 
Best regards until December 

 

Download all DNL-DERIVE- and TI-files from 
http://www.austromath.at/dug/ 

http://www.derive-europe.com/support.asp?dug 
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The DERIVE-NEWSLETTER is the Bulle-
tin of the DERIVE & CAS-TI User Group. 
It is published at least four times a year 
with contents of 44 pages minimum. The 
goals of the DNL are to enable the ex-
change of experiences made with DERIVE 
and the TI-89/92/Titanium/Voyage 200 as 
well as to create a group to discuss the 
possibilities of new methodical and didac-
tical manners in teaching mathematics. 
 
As many of the DERIVE Users are also 
using the CAS-TIs the DNL tries to com-
bine the applications of these modern tech-
nologies. 
 

Editor: Mag. Josef Böhm 
A-3042 Würmla 
D´Lust 1 
Austria 
Phone/FAX: 43-(0)2275/8207 
e-mail:  nojo.boehm@pgv.at 

Contributions: 
Please send all contributions to the Editor. 
Non-English speakers are encouraged to 
write their contributions in English to rein-
force the international touch of the DNL. It 
must be said, though, that non-English 
articles will be warmly welcomed nonethe-
less. Your contributions will be edited but 
not assessed. By submitting articles the 
author gives his consent for reprinting it in 
the DNL. The more contributions you will 
send, the more lively and richer in contents 
the DERIVE & CAS-TI Newsletter will be. 
 
 
 
 
 
 
Next issue:  December 2006 
Deadline  31 November 2006 

 
Preview:  Contributions waiting to be published  
 Two Stage Least Squares, M. R. Phillips, USA 
 Some simulations of Random Experiments, J. Böhm, AUT 
 Wonderful World of Pedal Curves, J. Böhm 
 Another Task for End Examination, J. Lechner, AUT 
 Tools for 3D-Problems, P. Lüke-Rosendahl, GER 
 ANOVA with DERIVE & TI, M. R. Phillips, USA 
 Financial Mathematics 4, M. R. Phillips 
 Hill-Encription, J. Böhm 
 Farey Sequences on the TI, M. Lesmes-Acosta, COL 
 Simulating a Graphing Calculator in DERIVE, J. Böhm 
 Henon & Co, J. Böhm 
 Challenges from Fermat, Bj. Felsager, DEN 
 Are all Bodies falling equally fast, J. Lechner 
 Modelling Traffic Density, Th. Himmelbauer, AUT 
 Do you know this? Cabri & CAS on PC and Handheld, W. Wegscheider, AUT 
 An Interesting Problem with a Triangle, Steiner Point, P. Lüke-Rosendahl, GER 
 Mathematics and Design, H. Weller, GER 
 Diophantine Polynomials, D. E. McDougall, Canada 
 Challenger Matrix Problems, G P Speck, New Zealand 
 Precise Recurring Decimal Notation, P. Schofield, UK 

 and Setif, FRA; Vermeylen, BEL; Leinbach, USA; Koller, AUT; Baumann, GER; 
 Keunecke, GER, .........and others 

 

Impressum:  
Medieninhaber: DERIVE User Group, A-3042 Würmla, D´Lust 1, AUSTRIA 
Richtung: Fachzeitschrift 
Herausgeber: Mag.Josef Böhm 
Herstellung: Selbstverlag 
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Three mails from Bill Wilburn: 

I am glad to hear that the DNL will continue on. A while back, when I heard that Dr. Rich and Theresa 
were no longer with Derive, I suspected that this might happen. For a long while, I've been interested 
in Mathematica. So, I downloaded the trial version. I liked it. My wife got me Mathematica 5.2.0 Pro-
fessional for Father's Day. I'm still a novice with it. It has so many features. It's amazing, and you can 
do so much with it. I personally like all of the CAS systems. I've had no experience with Maple, but it 
appears to be a fine CAS system as well. I hope that you can get the latest version of Mathematica. I 
know that a person of your caliber certainly deserves it. 
  
Sincerely, 
Bill Wilburn 
 
PS. I'm looking forward to more issues of the DNL. 
 
Hi Josef: 
Here's an example of a Mathematica Notebook on solving 2 sets of parametric equations. 
I used DERIVE 6.10 as a word file to show the Mathematica Notebook's contents. 
I suppose that you could put it into a DNL if you wish. If so, please feel free to edit it as you like. 
  
Have a nice day, 
Bill Wilburn 
 
Hi Josef: 

I ran across this site and thought that you might be interested: 
  

http://curvebank.calstatela.edu/famouscurves/famous.htm 
  
Regards, 
Bill Wilburn 
 
You can find Bill´s example on page 38 together with the respective DERIVE treatment, Josef 
 
 
Manuel Garcia Mateos garcia_mateos@WEB.DE 

Hello Derivians, 
I tried to show that the sequence (1+1/n)^n <3 for all natural numbers by defining n as a positive inte-
ger and solving the inequality. 
Derive does not resolve the inequality for n. Derive produces the following output: 

 

Is there a way to show that the sequence is bounded and monotonuously increasing without using Ber-
noulli-inequality or other transformations? 
 
Regard the sequence e(n):=3*(-0.7)^n (n positive Integer) The sequence is bounded and converges to 
zero. but: solve(e(n)<5,n) leads to false! 
Is there a way to show that alternating sequences are bounded? 
 
Greetings, 
Manuel 
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G P Speck, Wanganui, New Zealand 

Dear Josef: 
I t was good to receive your email and pleasing to hear that you remember Wanganui fondly. 
For various reasons I’m having difficulty sending technical material via email – so for this one time I 
am sending a disc with the Derive V.5 file ch_0(Challenger).dfw  containing my paper Challenger 
Matrix Problems which you viewed previously.  With this disc you can, of course,  modify the format 
however you wish for sending to DUG members.  Not being familiar with Derive V.6 until I receive 
my copy, I hope that this will be no problem. 
In the meantime I’ll try to get my difficulties on margins, matrices, email formats, and other printing 
matters sorted out. 
Keep up the good work with Derive – we’ll hope that most of the good features of Derive will be 
maintained in NSpire. 
Sincerely, 
G P Speck 
Many thanks to G P. The diskette arrived in Würmla and its contents will make a fine article 
for a new ACDC-column. Josef 
 
Peter Schofield, UK 

Hello Josef, 

Thank you for your news letter informing me of the end of TI's interest in Derive. I'm quite upset 
about it, but I suppose it was coming from the time they decided not to employ Albert anymore. I have 
strong reservations about "Nspire" and what it is intending to achieve. I fear that many of the wonder-
ful aspects of Derive will be lost.  

Anyway, I am attaching a short article - together with corresponding Derive and TI-89 files - on how a 
precise recurring decimal notation can be set up in Derive 6 and on the TI-89. I hope this might be 
suitable for the DUG? 

All the best 

Peter 

Peter´s contribution is on my stack and will be published in the next DNL. 
 
Peter Witthinrich, Germany 

Lieber Josef Böhm, 

schade, dass die Entwicklung von Derive eingestellt wird. Derive ist in meinem Umfeld eher akzep-
tiert worden als die CAS-Rechner, ich habe es im Unterricht deutlich häufiger als die Kleinrechner 
eingesetzt. 

Hoffentlich übersieht TI nicht, dass so gut wie alle Schulen ohnehin einen Computerraum haben, sich 
aber nicht alle Schulen zusätzlich noch weitere Rechner anschaffen können.  

Außerdem gibt es inzwischen eine Anzahl weiterer Computeralgebrasysteme, auch wenn Derive aus 
meiner Sicht besonders (oder besser als die anderen) für den Schulbereich geeignet ist. Manche Lehr-
kräfte steigen vielleicht einfach um, zumal einige CAS kostenlos sind oder die Grundversion (die in 
vielen Fällen für den Unterricht ausreicht) kostenfrei ist. 
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Meistens hat bisher der Elternverein die kleinen Rechner bezahlt. Jetzt werde ich den Eltern klarma-
chen müssen, dass nach der noch nicht so lange zurück liegenden Anschaffung der Voyage200 schon 
wieder ein neuer Typ besorgt werden soll. 

Zur DUG denke ich, dass sie doch ohnehin bereits auf CAS-Rechner erweitert war. So sehe ich keinen 
Grund, sie nicht bestehen zu lassen. Falls erwünscht könnte sie später immer noch erweitert oder um-
benannt werden. 

Mit besten Grüßen 
Peter Witthinrich 
 

Lisa Townsley, USA, sent a short answer wrt my report on the "(non) Future" of DERIVE in my DUG-
Information. I am very happy these three sentences. Many thanks on behalf of the DUG, Lisa. We will 
go on. 

Josef,  
This was a nice, sensitive note to send. I have shared your words with my department. The 
best part about using Derive is the excellent colleagues all over the globe.  
 
I sent Karsten Schmidt my paper about the "nonlinear" regression (page 25) and he sent back an ex-
tended and interesting answer. I try to translate his mail (JB.dfw and the pdf-file can be downloaded). 
 
Dear Josef, 
in the meanwhile I dealt with your mail from, in particular with your first example (n = 10). (page 25). 
 
The extremal value problem Φ(x)=a*1+b*sin(x)+c*cos(x) is a linear regression with 3 exogene vari-
ables (including a pseudo variable for the intercept). Even if sin(x) and cos(x) are created by a nonlin-
ear transformation, the regression model remains linear.  
 
This can easily be observed by inspecting your matrix M, which corresponds to matrix X' in chapter 
12 of our textbook (published by Springer, for an example see page 218)1. I reprodruced the procedure 
in DERIVE using the “usual” notation (file JB.dfw). #3 creates the regressor matrix X from x.; KQ- 
estimation with X and y leads exactly to your result. #7 and #8 allow a 2D-scatter plot together with 
the regression line. (Comment: I believe that KQ is "kleinste Quadrate" = "least squares".) 
 
The 2. attachment is the pdf-SPSS output. 
1. page: Scatterplot and "linear" regression; 
2. page: nonlinear regression with model equation a+b*sin(x)+c*cos(x), i.e. the model from above 
with transformed variables, which leads to the same results; 
3. page: nonlinear regression with model equation a*sin(b*x+c)+d, which is equivalent to the SinReg-
treatment of the TI-92+/Voyage 200, which gives the same result as in your paper.also entsprechend 
dem Ansatz SinReg des TI-92, es kommt auch das raus wie in deinem Text. 
 
Under "Residual"/"Sum of Squares" you can fin in SPSS the respective SSE - sum of squared errors – 
(twice 1.772 and once 1.645), which shows that the (true) nonlinear regression fits better. 
 
By the way, this is a fine demonstration of Gauß-Markow-Theorem which says that the KQ-estimator 
(LS-estimator) is the best (i.e. minimizing variance) of all linear unbiased estimation function, because 
the better estimator is a NONlinear one!    Best regards - Karsten 

                                                      
1 see our book shelf. 
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Thick Lines and Colour Pots in DERIVE 
Tania Koller, Austria 

 
My colleague Tania gave a great presentation in Dresden (on the Proceedings 
CD). Among many other “motivativing activities” for students she showed her “Cin-
deralla´s Shoe” modelled by cubic splines. I have seen this earlier, but look at her 
“DERIVE picture” of the shoe: thick lines and a bright pink, which is not among the 
DERIVE shading colours. I asked how she produced thick lines in DERIVE which 
has been a long requested feature of DERIVE, and how she brought the colour on 
the shoe. Here is her answer with some additional comments. Josef 

 

      
 
 

 

Set Option > Display > Points Connected and 
Large and Plot #2 (don´t forget to set Options 
> Approximate before plotting. 
 
Then Set Option > Display > Points con-
nected and Medium and Plot #3. 
 
Finally plot #4. Choose colours as appropri-
ate. 

 
 

 
 

 
If you intend to use this nice tool more often then you might use a function with fixed parame-
ters which can be changed if needed. 
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In function thick()variable and the increment of the table are preset with x and 0.01. In most 
cases these defaults will be fine – and you need only entering function and boundaries: 

 
 

 

 
 

I enter variable t and see that the steep-
ness of the graph needs a smaller incre-
ment. 

 

 
 

Now it looks fine. 
There is no Anti-Aliasing-algorithm – so set the 
points as tight as possible. 

 

The slider bar is one of my favourite features of DERIVE 6 (and as I know, it is also very of-
ten used by Tania in classroom). So I am very happy that the "Thick- and Medium-Line-Trick" 
is wonderful supported by the slider bars. Sometimes it needs some moments to create the 
graph, but then the slider bars work without any delay.  
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In parameter form we do not need this trick, because we can enter the size of points: 

 

 
Plotting in Size Medium we face 
problems because of the restric-
tion to plot a maximum number of 
640 points. To obtain a smooth 
line one has to plot in intersections 
0 - π, π - 2π, etc. 

Or we try to overcome this restric-
tion by defining a function applying 
the more or less unrestricting 
VECTOR-command: 
  

 

 

 
 

Incited and inspired by Tania´s method I wanted to do implicit plots in three line thicknesses, 
but this is not so easy to perform. One idea is to adapt the utility for plotting level curves (see 
another contribution in this DNL). I tried another way: Scanning the area in small x- and y-
increments and plotting the points which fullfill the implicitly given equation of the curve: 



 
 
 p10  
 

 
Tips from Tania: Thick Lines and Painting in DERIVE  

 
 D-N-L#63 
 

 

 

 

(I´ll come back to this “Superellipse” in the next DNL, Josef) 

I wanted to test my function and invented a strange implicit form and DERIVE gave immedi-
ately its graph: 

 
 

But we want the graph as a 
medium or as a thick line. 

Autograph is not a CAS but 
has a lot of great features, 
with a very powerful graphic. 

I plotted the expression with 
a thickness of 3 ½ pts: 

And I took DPGraph to plot the left hand side surface together with the plane z = 1 for better 
illustration: 
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Autograph above and DPGraph at the right 
hand side… 
And the DERIVE – Plots below! 
 

  

 
                          Point Size Large                                Point Size Medium 

Another possibility is offered by adapting one or the other function of producing contour- or 
level plots (see the contour plot - contribution in this DNL). If you don’t mind calculation time 
then try the following and plot applying different point sizes: 
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Now let´s turn to Painting in DERIVE. Tania told me that one of her students (Eva Maria 
Korntheuer, 16 years) came across an Option in the Edit-Menu which was never mentioned 
in class before: Edit > Bitmap-Object. (Have you ever noticed this?). Just for fun she wanted 
to know what would happen. She converted the graph (eg a circle) into a Paintbrush Picture. 
And then with a double click on this picture she found herself in the Windows Tool Painbrush 
with all its features at her disposal. Many thanks Eva Maria and keep your interest and curi-
osity. (She created the bear on page 14.) 
 

 
 

 



 
 
 D-N-L#63 
 

 
Tips from Tania: Thick Lines and Painting in DERIVE  

 
 p13 
 

 
In the Graphics Program you can manipulate the graph – remaining in DERIVE – as you like 
and clicking in the DERIVE screen (eg on the expression) you see the coloured graph. Any 
double click on it leads back to Paintbrush for further treatment. 
 

  
 

Tania´s students created a whole gallery of pictures using various functions. She sent a se-
lection of pictures and I am very happy to present a part of this gallery in the DNL. 
 
 

 

I found the graph below in a mathematics book it is a chal-
lenge for students to reproduce this pattern. 
 

 
 
It is not so easy to find the mathematics behind. This is one way to produce a similar pattern 
by two families of curves. The graph was distorted in Paintbrush and then the tiles could be 
filled. 

    
You can change the DERIVE built in colour palette, but the shadings look pale because of 
the shading algorithm, the Paintbrush colours are really bright colours! And it would be very 
tiresome to shade the many facets of the pattern above … and of the graphs on the next 
page! 
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Gallery of DERIVE-Graphs treated as Paintbrush-Pictures 
(produced by Tania´s Students of the Handelsakademie St. Pölten, Lower Austria) 

     

 
 
The dromedary (by artist Daniel Wailzer) is made up by a list of polynomials up to degree 10! 
 
You can find a lot of other students´ products in Tania´s great presentation given at  
DES-TIME 2006 in Dresden on the Conference CD. 
 
 
 
Unfortunately Tania did not unhide her secret how to bring 
colour on the screen of her Voyage 200!! Josef 
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TI-Nspire – The next Generation? 
Bernhard Kutzler 

Linz, Austria 

 

At this year’s Derive conference Texas Instruments and Soft Warehouse Europe announced the dis-
continuation of Derive. The reason is that TI will soon release their new CAS product TI-Nspire and 
in the future all development and marketing resources shall be focused on this new product. TI-Nspire 
carries the technology of the legendary TI-92 further into a new generation Math/CAS tool.  

This article is written for people familiar with Derive and presents some TI-Nspire features which are 
not available in Derive, hence can be regarded an enrichment by a Derive user. This text is based on a 
pre-release version of the TI-Nspire software (version 1.0.500). The same can be performed on a 
handheld, on which some of the screen images look slightly different. 

There are many features in Derive 6 which are not (yet) available in TI-Nspire. Most of these features 
are there, because the user community demanded them. These features resulted from the feedback of 
countless teachers who used earlier versions of Derive in their classrooms and reported their findings 
and suggestions to the Derive development team. Clearly, if you use such a feature in your classroom, 
you would miss it in TI-Nspire, in particular if you were among those who asked for it. 

There are exciting features in TI-Nspire which we had asked for in Derive, but our wishes were not 
(maybe could not be) granted. So the ideal would be a union of both products …  

In all areas of life we see technology leaps. From 1967 to 1972 NASA used Apollo rockets for their 
space flights with Apollo “versions” 1-17. Then they changed to the Space Shuttle program. Today we 
use cars with combustion engines which burn oil products. In a world with oil getting short, hence 
getting more and more expensive, we will soon need a “technology upgrade” to a next generation of 
motors using alternative fuels. Change is the essence of life! 

TI-Nspire is an exciting new product. Its modern design has a potential which goes far beyond what is 
practically possible in Derive. By offering, seamlessly integrated, computer algebra, dynamic geome-
try, spreadsheet technology, word processing, data collection, and data exchange with a handheld, you 
now have, “under the same roof”, all technologies which are used today in mathematics teaching.  

My hope is that many Derive users will look at TI-Nspire, test it in the classroom, compare it to De-
rive, and help with their feedback to shape TI-Nspire so that it will be not only Derive’s declared suc-
cessor, but will become an upgrade to Derive, hence a true “next generation”. When comparing the 
two products we do need to bear in mind that Derive is an adult, while TI-Nspire is a new kid on the 
block, quickly growing up in today’s (software) world, certainly having a long and exciting future 
ahead. So please see the potential – and help turning as much as possible into reality. 
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TI-Nspire  

In the opening screen of TI-Nspire the preview pane on the left shows the overall structure of the 
document. A TI-Nspire document is a collection of “problems”. (An empty document starts with only 
one problem, named “Problem 1”.) Each problem is a collection of “pages”. Each page can be used as 
a whole or it can be divided into up to four sub pages. Each page (or sub page) can be connected to 
one of the following four applications: “Calculator”, “Graphs & Geometry”, “Lists & Spreadsheet”, 
and “Notes”. Right of the preview pane is the working area, which shows the selected “page”, hence 
offers an interactive environment for the respective application (or applications, if the page was di-
vided into sub pages). 

     

The left screen image shows a page which was divided into three sub pages, but with no applications 
connected to them yet. The right screen image shows a second page added to the first page, with a 
menu open for connecting an application to it. 

 

Calculator / CAS 

The “Calculator” application provides the CAS and corresponds to the “Home” screen on a TI-
89/92/92+ or Voyage200. 

When entering expressions one receives a lot of valuable support. Say, we want to input 
sin( )x x x+ + . After typing x+x+si, the following is displayed on the screen: 

 

Variables are displayed in italics and currently this would be interpreted as the sum of the three terms 
x, x, and si. As soon as we type the letter n, we see on the screen: 

 

TI-Nspire now recognizes the string sin as the name of a built-in function, hence does not display it 
in italics any longer. Adding the letter x leads to: 

 

Now the third term, sinx, is all displayed in italics, because it is interpreted as the name of a four-
letter variable. This is a clear “warning” to the user that this is not the intended input, which was the 
sine of x, simply because there need to be a pair of parentheses around the argument of the sine func- 
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tion2. We delete the last character, x, with the backspace key and add an opening parenthesis, (.  

    

TI-Nspire automatically introduces a matching closing parenthesis with the cursor placed in between. 
Typing x completes the desired input: 

 

The automatic insertion of a matching parenthesis is a great help to avoid “missing parenthesis” errors. 

Entering the input with the return key  produces a pair of expressions, comprising the entry and 
the answer, the latter being the (algebraically) simplified version of the entry. 

 

Unlike Derive and like the TI-92/89 or Voyage200, TI-Nspire automatically simplifies every entry. 

For entering powers, derivatives, integrals, systems of equations, limits, sums, products, matrices, 
piecewise defined functions, and certain function logic constructs (such as if-then-else and loops) TI-
Nspire offers two-dimensional templates. Say, we want to compute the derivative of 2 ln( )x x . We 

type x, then hit the keyboard’s power key   followed by the digit 2. 

      

The 2 is displayed as a raised-up exponent. The current position of the cursor indicates that the next 

character would be entered on the exponent level. The right arrow key   exits the exponent level 

and brings the cursor down to the level of variable x. The tab key  would do the same. 

 

Since there is no ambiguity, we may simply type “ln(x”, i.e. without a multiplication symbol (and 
also without the closing parenthesis).  

 

For computing the derivative we can choose the corresponding function (and template) from the Ex-
pression Templates menu or the Calculus menu: 

      

                                                      
2 TI-Nspire, like the TI-92/89/Voyage200, does not offer Derive’s Character Input Mode. 
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We open the Expression Templates menu, … 

 

… from which we choose the Derivative template. 

 

The red dots under and the vertical cursor left of the left-most (and lowest) dashed rectangle indicate 
that the next input goes into this position. Obviously this is for the variable. We type x followed by 

the right arrow key  (or the tab key ) to move to the next input field. 

      

The second input field is for the order of the derivative. If left empty, a first order derivative will be 
computed. This is what we want, hence we need not input the number one, but can move to the next 

input field with  or . 

 

There are several techniques to input expression 2 ln( )x x  as the third argument. Note that it was en-
tered already in the previous step. Hence, we could type ans (which is an abbreviation of “answer”) 
as a reference to the previous answer, i.e. the desired expression. As an alternative we use the up-

arrow key  to highlight the last answer, … 

 

… then we use the enter key  to paste a copy of the highlighted expression at the position where 

the input cursor was before choosing this expression. Another use of the enter key  completes the 
input. 

         

 



 
 
 D-N-L#63 
 

 
Bernhard Kutzler: TI-Nspire – The next Generation?  

 
 p19 
 

  
 

In general Derive’s CAS engine is still more powerful than TI-Nspire’s CAS engine, but there are 
already a few exceptions, such as solving trig equations, … 

 

… for which TI-Nspire may offer all solutions (by introducing a parameter, n2 in our example). 

 

 
Recently there has been a debate about how Derive approximates expressions involving inverse trig 
functions in degree mode. When we use Derive to simplify, everything is fine:  

 

However, when we approximate these expressions, the resulting angles are given in radians – even if 
the system is set to degree mode.  

 

One can obtain degree answers when using ARCSIN instead of ASIN, … 

 

… but this is not satisfactory when solving trig equations. 
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If the above is a nuisance to you, you probably will find the answers provided by TI-Nspire to your 
liking. 

    

 
 

TI-Nspire offers the option to represent complex numbers in either rectangular or polar form: 

   

 
í  

TI-Nspire also offers a statistics menu with a lot of useful functions. 

 

 
 

The user interface allows the typical Windows-standard mouse-click-and-drag method to select any 
part of an expression on the screen.  

   

In combination with the usual cut-copy-paste technique this is useful when building new expressions 
from old ones. However, other than in Derive, the selection of portions of an expression is not re-
stricted to valid subexpressions. 
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Graphs & Geometry 

We use the Insert>Graphs&Geometry command to add a page for function graphing and interactive 
dynamic geometry. 

 

The preview pane on the left now shows a reduced calculator page and a reduced graphing page, both 
of which are not interactive. One can easily flip between pages (i.e. making them interactive) by click-
ing the desired page in the preview pane. 

In the upper right corner of the application window, next to the application window’s icon menu, the 
string 1)3 indicates that this is Page 3 of Problem 1. 

By the way, TI-Nspire offers a Presentation View and a TI-Nspire CAS+ Handheld View. The first one is 
very useful if one presents in a bigger room, the second one is very useful when the students use 
handhelds. In both views the preview pane is not visible. 

 

Back to function graphing. To obtain the graph of 2y x= , we enter the function term 2x  at the bot-
tom of the graphing window, hence turning the system reserved function name f1 into a user-defined 
function. As it is customary in TI’s graphing calculators, f1, …, f99 are reserved for this purpose. This 
technique is similar to producing graphs on a graphing calculator, where one enters the function terms 
in a “y=”-window. In TI-Nspire one sees only one function (and its definition) underneath the graph-

ing window and one can use the up  and down  arrow keys to scroll.  

 

 
Also here we have the two-dimensional input of expressions. After entering the input with , the 
graph is drawn and is appropriately labelled with f1(x)=x². 
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This graphics easily can be changed in many ways simply with the mouse. We choose the Pointer tool 
from the first menu, grab the horizontal axis at its left end (grabbing is performed by moving the 
mouse to the desired position, then clicking and holding the left mouse button) and extend it further to 
the left, … 

 

… then we grab the horizontal axes at one of its tick marks and change this axis’ scale factor, … 

 

… and finally we grab the entire plane (it can be grabbed on any white spot) and shift it around the 
window. 

 

For certain classes of expressions one can grab the graph, change its shape, and observe how the func-
tion term changes accordingly. 

   

Using the Attribute command, one can change the appearance of a graph or how the function graph is 
displayed. 
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TI-Nspire also offers many of the dynamic geometry features known from Cabri Geometré such as 
drawing a circle: 

 

 

Lists & Spreadsheet 

We use the Insert>Lists&Spreadsheet command to add a page connected to a spreadsheet. This spread-
sheet offers both column logic and cell logic. One can do the standards of what one can do with stan-
dard numerical spreadsheets; in addition this spreadsheet can carry and process algebraic expressions. 
The only limitation may be that within the cells the expressions are displayed in linear format, only by 
selecting a cell one can view its contents in two-dimensional format at the bottom of the page window. 

 

This is ideal for having students recognize patterns. Once they have an idea, such as for the above, the 
teacher may challenge them by adding an example for which the validity of their pattern needs some 
additional thinking, such as in the following screen image. 

 

 
Notes 

We use the Insert>Notes command to add a page for producing text. 
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By applying the Evaluate selection command, the selected expression is algebraically simplified, i.e. 
also the text processing application is connected with the computer algebra application. 

 

 

Miscellaneous 

Within a TI-Nspire document, user-defined functions and variable assignments are local to a “Prob-
lem”, within which they are valid in all pages. Other problems in the same document have their own 
local variables. 

A very useful command is the general Undo command, which undoes whatever has been done last. A 
corresponding Redo command is also available. 

 

For fast access to certain symbols or build-in functions, one can switch on the Keypad, which can be 
put next to the application window for convenient input. This is how the calculator keyboard looks 
like! 

 

Other sources for supporting the inputting of expressions are the Catalog with a list of all build-in 
functions in alphabetical order including a quick “online help” in form of “expressive” templates at the 
bottom of the window, …  

 

… and a Symbol Palette for special symbols and input templates.  
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Closing Remark 

TI-Nspire’s innovative double-platform design (handheld + 100 % compatible computer software) and 
the seamless integration of the various components (CAS, graphing, geometry, spreadsheet, text proc-
essing) make it a very powerful teaching and learning aid for teachers and students that is unique on 
the market and has great potential. Please help testing it. I’ll be happy to collect the feedback and for-
ward it to the appropriate people. 

 
 
 

Beyond Polynomial Regression and  
Beyond quartreg on the TIs! 

Josef Böhm, Würmla, Austria 

Well known – since several years even in school mathematics – are linear and quadratic regression, 
both based on the least squares method. One of the reasons that regression models found their way in 
class room is the increasing importance of statistics and another one is the availability of tools which 
make the tiresome numerical calculation easier or even unnecessary.  

Given is a set of bivariate data {(x1,y1), (x2,y2), ....., (xn,yn)}. Presentation of the data in a scatter dia-
gram sometimes leads to the conjecture that there might be a linear relationship between x- and  
y-values. Regression tries to find a linear model function f(x) = k x + d such that the sum of the squares 
of the differences between real and theoretical function values becomes minimal: 

Minimumydxkyxfdk
n

i
ii

n

i
ii =−+=−=Ω ∑∑

== 1

2

1

2 )())((),(  

This is an extremal value problem with two variables k and d. The values of them can be found by 
partial differention of Ω(k,d) with respect to k and d and then solving the resulting system of linear 
equations for k and d. 

This method is going to be generalized. Let´s have a demonstration example: 

(I will start working on the handheld, the DERIVE realisation will follow.) 

 
xi 1,36 2,14 2,76 4,40 4,99 5,85 6,89 8,25 8,50 10,09 

yi 3,65 2,65 -0,20 -2,12 -1,96 0,49 3,44 2,88 0,97 -2,11 

 

Store the data in two lists xl und yl and have a first impression by inspecting the scatter diagram: 
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We can be sure that linear regression is not appropriate in this case. We could try polynomial function 
of higher degree, but the scatter diagram reminds us on trig 
functions, doesn´t it? 

So we look for an approximating function Φ(x) defined as 
a linear combination of the set (list) of functions: 

{1, sin(x), cos(x)}. 

 

)cos()sin(1)( xcxbax ⋅+⋅+⋅=Φ  

We obtain an extremal value problem with three variables a, b and c: 
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The resulting equations can be cancelled by 2, expanded and rearranged: 

1 1 1 1 1

1

1

i i i
N N N N

i i i i i i i
N N N N

i i i i i i i
N N N N

a b sin x c cos x y

a sin x b sin x sin x c cos x sin x y sin x

a cos x b sin x cos x c cos x cos x y cos x

⋅ + ⋅ + ⋅ = ⋅

⋅ + ⋅ + ⋅ = ⋅

⋅ + ⋅ + ⋅ = ⋅

∑ ∑ ∑ ∑

∑ ∑ ∑ ∑

∑ ∑ ∑ ∑

 

The system is linear again. Our task is to set up the system for the given data (N = 10) and solve it. 
Then add the graph of the “regression line” to the scatter plot. We can use the lists xl and yl. 

Note: sum(list) gives the sum of all elements of a list.  

  10 a  +  1.533626 b  –  1.336507 c  =  7.690000 

  1.533626 a  +  6.006008 b  –  0.829608 c  =  16.119240 

  -1.336507 a  –  0.829608 b  +  3.993992 c  =  2.871270 

which leads to: Φ(x)  =  0.544245  +  2.748197 sin x  +  1.471855 cos x. 

The Calc-Menu ‡ in the DATA-MATRIX-Editor of the 
TIs offers option SinReg which gives a sinuoidal regres-
sion line.  

The result is: 

y(x)  =  3,09219 sin(1,02073 x + 0,37917) + 0,54421 

thick: Φ(x), line: y(x) and dot: quartreg 
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We compare the quality of both regression lines by calcu-
lating the sum of the squares of the residuals. The TI-built-
in trig regression proves to be a little bit better. 

 

Calculating the trig regression line is much much more 
complicated (see DNL# 46) 

The method shown above can be performed very elegant by using matrix algebra. First of all we create 
matrix M, the so called Normalmatrix: 

 
















=
















=

)cos(................)cos()cos()cos(
)sin(..................)sin()sin()sin(

1........................111

)(...........)()()(
)(...........)()()(
)(...........)()()(

10321

10321

103332313

102322212

101312111

xxxx
xxxx

xfxfxfxf
xfxfxfxf
xfxfxfxf

M

 

What ist he result of M ⋅M‘? 

 

Solving the simultaneous equation is easily done: 

 

Please compare with the solution from above! 

 

Her is a problem for you(r students): 
 

xi -0,51 1,34 3,57 5,77 7,34 9,49 12,37 14,89 

yi -3,15 -12,90 -9,14 -13,54 -8,81 -10,33 -5,20 -3,23 

xi 15,34 18,09 19,86 21,25 24,48 26,04 28,42 30,83 

yi 2,61 9,17 11,49 16,02 26,80 31,01 38,98 46,21 

 
The approximating function shall be a linear combination of: 

f1(x) = 1, f2(x) = x2, f3(x) = (x+1)-1 und f4(x) = (x+2)-2. 

Try to use appropriate TI-functions to keep edit-
ing as little as possible.  

 

You can read off the solution: 

 
Possible questions for students: 

Can we use a polynomial of higher degree as regression line? Do you find another sensible 
set of basic functions? Compare the quality of the regression models by calculating the SSE 
(sum of squared errors = sum of squares of residuals). This method can help to overcome 
the restriction of polynomial regressions on the TI. Do you have any idea how to do? 
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Realisation with a DERIVE-function 

Transfer to DERIVE is very easy, because we can use the TABLE-function very efficiently to create 
the normalmatrix. A three-lines program does the whole job: 

 

Big surprise? Or not? 

 
Please read Karsten Schmidt´s com-
ment on this kind of regression (page 5) 
and read the paragraph on the FIT-
function in the Online Help of 
DERIVE. 

You might ask if our work was super-
fluous and waste of time? My opinion 
is: No, because we could make a “Black 
Box” to a “White Box” with relatively 
little effort. 

Let´s compare with the sinreg(datamatrix) program for trigonometric regression. 

In 2002 Don Phillips provided a wonderful tool based on the Levenberg-Marquardt and Gauss-
Newton Methods for nonlinear regression models. 3 

 
 

 

                                                      
3 Derive Newsletter #46, Statistics-Tools for DERIVE and the TI-92 
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test2 is the data matrix of the 2nd example (and try again with the FIT-function and compare!): 

 

 
 

Programming for the CAS-TI-Calculator 
genreg(functionlist, data matrix) is the respective program fort he TIs.  
A special list of functions (powers of x) leads immediately to a higher degree polynomial regression 
polreg(degree, data matrix). (See the screen shot on the next page.) 
genreg 
(flist,pts) 

Prgm 
Local nm,rs,xv,yv 
pts[1]→xv:pts[2]→yv 
newMat(dim(flist)[2],dim(xv)[2])→nm 
newMat(dim(flist)[2],1)→rs 
For k,1,dim(flist)[2] 
   For l,1,dim(xv)[2] 
      limit(flist[1,k],x,xv[1,l])→nm[k,l] 
   EndFor 
   dotP(yv,nm[k])→rs[k,1] 
EndFor 
 (nm*nm)^(⁻1)*rs→rs 
dotP(rs[1],flist[1])→regf 
Disp regf 
Disp "" 
Disp "   Gespeichert unter regf" 

EndPrgm 
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Compare the results! 
 

The TI-program for polynomial regression pol-
reg() refers to genreg(): 

 

 
 

                
 

Compare again with the DERIVE result applying the FIT-function: 

 
 
A Closing Example: 

A Lorenz Curve is defined by the points (0|0), (0.2|0.03), (0.4|0.1), (0.6|0.25), (0.8|0.55) und (1|1)  
(= Quintil-values). The curve shall be modelled by a quartic passing the origin.  

This is no problem in DERIVE: 
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• Note: In economy the Lorenz curve is used to represent the inequality of eg. income distribution 
among different groups in the population of a country. This inequality of the distribution is meas-
ured by the GINI coefficient, which measures how far the Lorenz curve falls below y = x. It is the 
ratio of the area between y = x and the Lorenz curve and the area between y = x and y = 0. (This is 
a very welcome application of the defined integral.) 

 
From today on this is no problem for you as a TI-User, too: 

         
 

         
 
For higher degree polynomial regression it can happen that the matrix will become singular caused by 
internal calculation inaccuracy. 
 
References: 
[1]  R.  J. Hill & T. A. Keagy, Elementary Linear Algebra with DERIVE, Chartwell-Bratt 1995 
[2]  H. D. Hinkelmann u.a., Mathe mit Gewinn 2 & 3, oebvhpt 2005, 2006 
[3]  H. D. Hinkelmann u.a., Mathe mit Gewinn 3, oebvhpt, 2006 
[4]  Josef Böhm, Matrizenrechnung mit dem TI-92, T3-Skriptum (www.acdca.ac.at) 
[5]  Ronald Harshbarger & J J Reynolds, Mathematical Applications, Houghton Mifflin 2000 
[6]  Karsten Schmidt & Götz Trenkler, Einführung in die Moderne Matrix-Algebra, Springer 2006 
[7]  Derive Newsletter #46, March 2002 
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Contour Plots – Level Curves 
Peter Schofield, UK & Josef Böhm, Austria 

In DNL#59 appeared a request from Manuel Garcia Mateos for plotting level curves  
(= contour plots) with DERIVE. Manuel was right complaining that other major CAS-
programs (MAPLE, MATHEMATICA) provide packages for creating contour plots either 
in the xy-plane or as a 3D-plot. Producing a plot in the xy-plane is not so difficult using the 
VECTOR-command and DERIVE´s ability to create implicit plots. As a “Graphic Freak” I 
wanted to overcome the deficiency of presenting the contour curves in 3D and started 
thinking about a program. Now, since I am able to use three thicknesses of lines in the 
plane we have more varieties plotting even in plane. Peter Scofield who is also a graphics 
enthusiast and a real graphics wizard joined the party and gave his version of facing the 
challenge. Moreover Peter produced a toolbox for plotting implicit forms of three variables 
and found an improved version of NSOLUTIONS and NSOLVE. 

I´ll demonstrate what we did using function f: 

Finding the contour plots in xy-plane is not too difficult: 

           

              

Two more examples of plane contour plots with their graphs on the next page. 

 
 

 

We want to see the level curves in 3D-plot – either on the surface or as projection on the xy-plane – 
and we would like to plot the 2D-level curves in various thicknesses. 
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For the following I need my auxiliary function mysolutions, which – as I am hoping – finds all nu-
meric solutions of equation equ vor variable equ_v in the range between x =  start and x = end. 

 

This is the first half part of my programm contour().  

 
 

I enter any equation with three variables x, y and z as f. level is the distance of the level plane from 
the xy-plane. The plot range is defined by xst ≤ x ≤ xend and yst ≤ y ≤ yend. In the 3rd line f will 
change to an implicit form f(x,y) = level. In the following loop we substitute x by all values from xst 
to xend with an increment of xstep (default value 0.2) and try to find all solutions for y, which leads 
to points on the surface – if there are solutions. The first two parts in the IF-construct are necessary for 
special cases (f from line 3 can be returned as false, …). If you are fine with the default values, then 
entering parameters ends with yend. acc sets the accuracy for the mysolutions-procedure. 

Then we repeat the same procedure for the sequence of y-values to have a tighter point set. 

See my first results (don´t mind some calculation time!) 

 
Highlight the expressions, switch to the 3D-Plot Window (set Options > Approximate before Plotting) 
and Insert > Plot. When DERIVE is ready (in the background) you will be asked for the Point Size 
(Small / Medium / Large). Try any of them. Then you will be asked for the Plot Colour. Set Scheme 
Custom and set Top Maximum and Minimum the same colors. 



 
 
 p34  
 

 
Peter Schofield & Josef Böhm: Contour Plots  

 
 D-N-L#63 
 

  

  
 
Contour plots of #15 from above: 

      
This is not so bad. But if you choose Point Size Small, the points are not really small. I wanted to have 
only dots as points. It is not possible to have discrete points appearing as dots – either the points are 
connected or if dicrete, then small (which is not really small), medium or large. (This is what I know).  
So I wanted to have a “contour dust”. Peter gave the idea: plot a segment of length 0. [1,2,3;1,2,3] 
shows a tiny dot. So I only had to change the output form of contour to get contourdot() with the 
same parameters as before. 

 

 

 

 
See the plots on the next page: 
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And finally there is contourdotplane() which gives the projections of the level curves in the  
xy-plane but as a 3D-object: 

 

 
As it was mentioned in the contribution about plotting thick lines, it was not too difficult to adapt the 
basic idea creating contour plots for doing implicit plots with thick lines (which are in fact only thick 
points in a row). 

impplot() is a adaptation of contourdotplane().  

Peter sent a mail together with his files polycontour.mth and polycontour.dfw and just recently an 
improved version: 

 

Peter found a quite better auxiliary program for finding the numeric solution of an equation. I´ll pre-
sent this programs N_SOLUTIONS() and N_SOLVE() in an extra paragraph. 
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For 3D-representations Peter offers ContourPts_XY() and ContourDots_XY(). Using the first pro-
gram you can choose between the three point sizes Small / Medium / Large and the second one gives 
us the “dust”. An important EXTRA is the fact that his function can process Boolean expressions and 
operators.  
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In my short introduction I announced that Peter 
provided a file for doing implicit 2D and 3D-plots. 
Here are some mouth watering examples. I´ll 
come back to that in the next newsletter. 
 
Among the files which you can download your 
will find contours_j.dfw, contours_j.mth, polycon-
tours.dfw and polycontours.mth. The dfw-files 
contain the worked examples and the mth-files 
are containing the functions only. They should be 
loaded as utility files in the background. 
 
Happy scanning, 
Peter & Josef  

 
 

    
 

mysolutions versus N_SOLUTIONS 
 

Josef´s version for numeric solutions of equation equ (first lines of code): 

 
Peter´s version for numeric solutions of equation f (first lines of code): 

 
There is also a N_SOLVE-function which might substitute the DERIVE NSOLVE. Inspect the file. 
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See first, what DERIVE is offering:: 

 
If you add ‘Real’ as last parameter, then we obtain -9.4241… as the only one solution … 
Now let´s try what we can do: 

 

 
I took some other equa-
tions and finally I must 
surrender and admit that 
Peter´s tool is much better 
than mine, congratula-
tions. 
The nice thing is that 
Manuel Garcia´s request 
on contour plots lead us to 
fine results. We hope that 
some of you will find them 
useful for their work. 



 
 
 p40  
 

 
Bill Wilburn: Special CAS-Guest MATHEMATICA  

 
 D-N-L#63 
 

 
Find intersection points of a parametric 3D ellipsoid and a  

3D parametric straight line 
Bill Wilburn, USA 

 

solutions=N[Solve[xm4 Cos[s] Sin[t]&&ym3 Sin[s] Sin[t]&&zm2 Cos[t] 
          &&xmu+1&&ym3 u&&zmu+1,{x,y,z,s,t,u}]] 
 
Solve::ifun: Inverse functions are being used by Solve, so some solutions 
may not be found; use Reduce for complete solution information. More… 
 
{{x→0.,y→-3.,z→0.,u→-1.,t→-1.5708,s→1.5708},{x→0.,y→-3.,z→0., 
u→-1.,t→1.5708,s→-1.5708},{x→1.52381,y→1.57143,z→1.52381,u→0.52381, 
t→-0.704547,s→-2.19959},{x→1.52381,y→1.57143,z→1.52381,u→0.52381, 
t→0.704547,s→0.942}} 

 
{x,y,z}/. solutions 
 
{{0.,-3.,0.},{0.,-3.,0.}, 
 {1.5238095238095237,1.5714285714285714,1.5238095238095237}, 
 {1.5238095238095237,1.5714285714285714,1.5238095238095237}} 
 
plot1=ParametricPlot3D[{4Cos[s] Sin[t],3Sin[s] Sin[t],2Cos[t]}, 
      {s,-π,π},{t,-π,π},Axes→True,AxesLabel→{"X","Y","Z"}]; 
plot2=ParametricPlot3D[{u+1,3 u,u+1},{u,-2,2}]; 
plot3=Show[Graphics3D[{RGBColor[1,0,0],PointSize[0.025], 
      Point[{0,-3,0}]}]]; 
plot4=Show[Graphics3D[{RGBColor[0,0,1],PointSize[0.025], 
Point[{1.52380952380952,1.57142857142857,1.52380952380952}]}]]; 
Show[{plot1,plot2,plot3,plot4}] 
 
Null 
 

 
 



 
 
 D-N-L#63 
 

 
Bill Wilburn: Special CAS-Guest MATHEMATICA  

 
 p41 
 

 

 

 
I use the parameter form for the 3D-Plot (no mesh lines) and a similar trick as in the contribu-
tion on "Thick Lines" to plot the straight line as a thick line (Point Size Small is sufficient). 
The intersection points have Size Large. 

 
We can do it in another way, too: 
Substitute sin(t) = v and sin(s) = w and then square the components of line and surface.  
The system is now consisting of polynomials only and can be solved by DERIVE. 
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But there is also a “Black Box” – way, which doesn´t need more or less tricky manipulations. 
Students should know that there is a Newton Method for solving “uncomfortable equations” 
and they should learn that this method can be extended to more dimensions. In the DERIVE 
Online Help we can find via the index  item ‘system of equations’ a reference to Equation-
Solving.mth and there is a description of NEWTONS(u,x,x0) as a tool for approximative 
numerical solving of nonpolynomial systems. Let´s try: 
 

 
We can observe that the method converges to a solution: u = 0.5238…, s = 0.9420…  
and t = 0.7045… 
To find another solution we have to change the initial values (which is now an initial vector 
for u, s, and t): 

 
leads to the same solution, but: 

 
needs about 14 iterations to converge for the second solution. 

 
So we obtained the same intersection points as above. 

 
We could refine NEWTONS to make the output more friendly. In fact we are only interested 
in the last rows to see if and where the method is converging. 
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We don not only see the convergence, but also all solutions – 6 equations and 6 unknowns. 
For the other solution you have to take [0,0,0,0,0,0] as initial vector. 
 
I sent this treatment to Wilburn and a very few days after I received another mail with an im-
proved ( = more complicated) version of his problem. The centre of the surface moved out of 
the origin: 
 
Clear[sol] 
 
sol=NSolve[xm1.414213562 Cos[s] Sin[t]-1.719669914 Sin[s] 
Sin[t]+1.478397839 Cos[t]&&ym2.449489742 Cos[s] Sin[t]+2.217596759 Sin[s] 
Sin[t]+0.5606601717 Cos[t]&&zm-2.828427124 Cos[s] Sin[t]+1.060660171 Sin[s] 
Sin[t]+1.224744871 Cos[t]&&xmu+1&&ym3 u&&zmu+1,{x,y,z,s,t,u}] 
 
Solve::ifun: Inverse functions are being used by Solve, so some solutions 
may not be found; use Reduce for complete solution information. More… 
 
{{x→-0.02864356966104064,y→-3.085930708983122,z→-0.02864356966104064, 
u→-1.0286435696610405,t→-2.039686505060742,s→1.0160172805323466}, 
{x→-0.02864356966104064,y→-3.085930708983122,z→-0.02864356966104064, 
u→-1.0286435696610405,t→2.039686505060742,s→-2.1255753730574467}, 
{x→1.2890643961420396,y→0.8671931884261188,z→1.2890643961420396, 
u→0.2890643961420396,t→-0.12105797768231857,s→-1.7273026137850234}, 
{x→1.2890643961420396,y→0.8671931884261188,z→1.2890643961420396, 
u→0.2890643961420396,t→0.12105797768231857,s→1.41429003980477}} 
 
{{x,y,z},{s,t},{u}}/.{sol[[1]],sol[[3]]} 
 J8−0.0286436, −3.08593, −0.0286436< 81.01602, −2.03969< 8−1.02864<81.28906, 0.867193, 1.28906< 8−1.7273, −0.121058< 80.289064< N

 
 
aa=ParametricPlot3D[{1.414213562 Cos[s] Sin[t]-1.719669914 Sin[s] 
Sin[t]+1.478397839 Cos[t], 2.449489742 Cos[s] Sin[t]+2.217596759 Sin[s] 
Sin[t]+0.5606601717 Cos[t],-2.828427124 Cos[s] Sin[t]+1.060660171 Sin[s] 
Sin[t]+1.224744871 Cos[t], 
FaceForm[Hue[s/Pi]]},{s,-Pi,Pi},{t,-Pi,Pi},Lighting → False, 
Axes → True, AxesLabel → (StyleForm[#,"Subtitle",FontSize→12, 
FontWeight->"SemiBold"]&/@{"X","Y","Z"}), 
PlotLabel->StyleForm["Geometry",FontFamily->"Times", 
FontSize→18, FontWeight->"Bold"]]; 
bb=ParametricPlot3D[{u+1,3u,u+1,{Blue,AbsoluteThickness[2]}},{u,-2,2}]; 
cc= Show@Graphics3D[{{AbsolutePointSize[10],Red,Point[{x,y,z}/.sol[[1]]]}, 
{AbsolutePointSize[10],Red,Point[{x,y,z}/.sol[[3]]]}}]; 
Show[aa,bb,cc] 
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We have studied our lection in the first example, so we can start immediately solving the 
problem – now using immediately the Black Box (Try to do without!): 

 

 
 
                 Mathematica Graph             DERIVE Graph (Greyscale) 
 

   


